Google se hace movil.

ANDROID

El nuevo sistema operativo de Google se enfrenta cara a cara con el IPhone de Apple. Promete facilidad de
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uso, un montén de aplicaciones interesantes, conectividad total y un modelo de programacion sencillo

pero muy potente. POR ALBERTO GARCIA SERRANO

on Android, Google ha hecho
c una apuesta arriesgada

entrando en un mundo en el
que ya brillan con luz propia Nokia con
Symbian, Apple con su IPhone, Black-
Berry o Windows Mobile. ;Para qué
necesitaba el mundo un nuevo SO para
moviles? Existen algunas diferencias
que hacen de Android una opcién
muy interesante para los fabricantes, y
cémo no, para los usuarios y des-
arrolladores.

A diferencia de sus
competidores,
Android es software
libre, lo que permite
que los fabricantes
puedan usarlo sin
necesidad de pagar
royalties. Por otra
parte, al correr
sobre Linux, es
facilmente por-
table y adap-
table a
casi cual-
quier hard-
ware.

Android
no es el
primer
sistema
movil
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basado en Linux y que es software

libre. La propia Nokia abandera el pro-

yecto Maemo, e incluso Ubuntu des-

arrolla Ubuntu Mobile, pero no pare-

cen alcanzar la masa critica necesaria.

Android tiene todas las papele-
tas para triunfar donde otros
han fracasado.

Arquitectura

Como ya hemos comen
tado, el corazén de
Android es el ker-
nel Linux,
donde se
encuentran
los drivers
necesarios
para el
acceso al
hardware,
en con-
creto, para
la gestién

de la

davdibiase,
www.sxc.hu
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pantalla, el teclado, la cdmara, la red
Wi-Fi, el audio y la memoria Flash,
entre otros. En principio, el desarro-
llador no accederd directamente a esta
capa, sino que utilizard una serie de
librerias que estdn en un nivel supe-
rior y que nos abstraen del hardware.
Estas librerias, entre las que se inclu-
yen la propia libc, estdn programadas
en C. Otras librerias de este nivel son
SQLLite para la gestion de bases de
datos, FreeType para las fuentes de
texto, WebKit y SSL para la navega-
cién web y el cifrado de comunicacio-
nes, e incluso OpenGL ES para aprove-
char la aceleracidn gréfica del disposi-
tivo.

Aunque estén escritas en C, el pro-
gramador accede a ellas desde un API
de Java, que es el lenguaje que se usa
para desarrollar en Android. Para ello,
el sistema incluye una mdquina vir-
tual java (JVM). La mdquina virtual
que incluye Android se llama Dalvik,
y ha sido creada por Google para
correr en dispositivos con poca memo-
ria y poca capacidad de pro-

ceso. A diferencia de la JVM
de SUN, Dalvik ejecuta
archivos .dex en lugar de
los cldsicos archivos .class
de Java. Los archivos .dex
son mds compactos y estan
mds optimizados para el
entorno del teléfono. No dispondre-
mos de toda la API de JavaSE o
JavaME, sino que se incluye un sub-
conjunto llamado Core Libraries.

Toda la programacién del dispositivo
se hace usando el Framework de aplica-
cion, que nos ofrece todo lo necesario.
Cosas como el ciclo de vida de la apli-
cacién o la gestion de recursos, se ges-
tionan desde aqui.
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Listado 1: main.xml.

01 <?xml version="1.0"
encoding="utf-8"7>

02 <LinearlLayout
xmlins:android="http://schemas.
android.com/apk/res/android”

03
android:orientation="horizonta
1"

04
android:layout_width="fi11_par
ent”

05
android:Tlayout_height="fill _pa
rent” />

06

07 <EditText
08 android:id="@+id/url_text”
09
android:Tlayout _width="wrap_con
tent”

10
android:layout_height="wrap_co
ntent”
11 android:layout_weight="1"
12 android:1ines="1" />
13
14 <Button
15
android:id="@+id/nav_button”
16
android:layout_width="wrap_con
tent”
17
android:layout_height="wrap_co
ntent”
18

android:text="@string/go_url”
/>
19 </LinearlLayout>

Finalmente, en la capa superior estdn
las aplicaciones de usuario, desde el
navegador web hasta la propia aplica-
cién que nos permite llamar por telé-
fono pasando por las aplicaciones de
Google, como Maps o Gmail.

Teléfonos

El primer teléfono en utilizar Android
ha sido el HTC G1. Desgraciadamente,
en Europa sélo lo comercializa T-
Mobile, que no ofrece servicio en
Espafia. Sin embargo, en el momento
de escribir este articulo, Telefénica
Movistar ha comunicado que va a
comercializarlo (bajo el nombre de
HTC Dream) y Vodafone estd a punto
de comercializar el HTC Magic (tam-
bién conocido como HTC G2). Proba-
blemente, cuando lea estas lineas
ambos teléfonos estardn ya disponi-
bles.

En principio, son muy parecidos. El
HTC Dream incluye un teclado fisico
que no incluye el HTC Magic, a cambio,
HTC Magic incorpora mds capacidad de
memoria ROM y una bateria mds lon-
geva. En el Cuadro 1 se describen las
caracteristicas de ambos.

El Entorno de Desarrollo

La ultima versién del SDK de Android
es la 1.1. Puede descargarse de [1]. El
SDK nos ofrece, ademdas de un emula-
dor, todas las aplicaciones y librerias
que vamos a necesitar para desarrollar

aplicaciones. El emulador recrea per-
fectamente un movil Android, por lo
que, en principio, casi todo el
desarrollo podremos hacerlo sin usar
un terminal real. Para instalar el SDK
s6lo hay que descomprimir el archivo
que hemos descargado en un directorio
(por ejemplo, /opt/androidSDK/), y ya
podremos empezar a trabajar con el
SDK; sin embargo, usarlo directamente
puede ser un poco engorroso.
Afortunadamente, han pensado en
todo y han creado un plugin para
Eclipse que nos va a facilitar mucho el
trabajo. Instalar el plugin en Eclipse es
sencillo. Lo primero es descargar
Eclipse de [2] en caso de que no lo ten-
gamos ya instalado. Lo iniciamos, y
seleccionamos el mend Help > Soft-
ware updates... Tras seleccionar la pes-
tafla Available Soft-
ware, pulsamos el
botén Add Site... y
afladimos la  URL
https://dl-
ssl.google.com/
android/eclipse/. Pul-
samos OK. Nos apare-
cerd el nuevo sitio en
el listado de la pestana
Available Software. Lo
marcamos y pulsamos
el botén Install. A par-
tir de aqui sélo hay
que seguir los pasos
que nos va indicando

Contactos

Librerias

WWW.LINUX-MAGAZINE.ES

FreeType

Android - DESARROLLO

Eclipse. Una vez instalado, selecciona-
mos Window > Preferences >
Android, y pulsando el botén Browse,
seleccionamos el directorio donde
hemos instalado el SDK. Ya podemos
empezar a crear nuestra primera apli-
cacion.

Modelo de Programacion

Antes de crear nuestra primera aplica-
cién Android, vamos a exponer algu-
nos conceptos que habra que tener pre-
sentes a la hora de crear aplicaciones.
Empecemos con las Actividades (Acti-
vities). Una Actividad se corresponde
con una pantalla de la aplicacién, es
decir, que tendremos tantas actividades
como pantallas tenga nuestro pro-
grama. Cada Actividad es responsable
de mantener su estado, de forma que
puedan integrarse en el ciclo de vida de
la aplicacién, que es gestionado por el
propio framework de aplicacién. En
Android podemos crear las interfaces
de usuario de dos formas, desde la pro-
pia actividad usando cédigo Java, o
usando un fichero XML para describirla
como si fuera una pdgina HTML. Esta
ultima es la manera mds sencilla y
comoda.

Otro elemento importante son los
Intents. Un Intent es un mecanismo
para describir una accién, por ejemplo,
hacer una foto o enviar un email. Todas
las acciones que queramos realizar la
haremos mediante Intents. Este meca-
nismo es muy flexible ya que, por
ejemplo, podriamos crear una actividad
para envio de mensajes SMS y regis-
trarla de forma que maneje el Intent
correspondiente. De esta forma,
cuando alguien quiera enviar un SMS
mediante este Intent, se invocara nues-

Aplicaciones

Teléfono Navegador

Framework de apl

Runtime Android

Framework Libre
multimedia

Kernel Linux

Figura 1: Arquitetura de Android.
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Figura 2: Nuevo HTC Magic de Vodafone.

tra actividad en vez de la actividad por
defecto para envio de mensajes. En el
ejemplo que desarrollaremos en este
articulo, le pediremos a Android que
abra una pdgina web mediante un
Intent, y el sistema operativo sabra qué
aplicacion tiene que utilizar para ello.

Los Servicios (Services) son tareas
que corren en segundo plano, como si
se tratara de un demonio Unix. Imagi-
nemos que queremos hacer sonar un
MP3, pero mientras escuchamos, que-
remos poder seguir usando el teléfono.
Mediante un servicio, podemos dejar
sonando la musica de fondo mientras
usamos otras aplicaciones. Una activi-
dad puede luego acoplarse a un servi-
cio para, por ejemplo, parar o cambiar
la cancidn.

Por ultimo, los Proveedores de con-
tenido (Contents Providers) almacenan
datos que son compartidos por todas
las aplicaciones. El acceso a esos datos
se hace a través del API definida para
cada proveedor de contenidos. Un
ejemplo de proveedor de contenidos
que ofrece Google son los contactos
que tenemos almacenados en nuestro
teléfono. Desde nuestra aplicacién
podremos acceder a los contactos
usando el proveedor de contenidos
correspondiente.

Nuestro Primer Programa

Vamos a crear nuestro primer programa
Android, y para ello vamos a usar

Numero 49

52

Eclipse. Para mostrar las capacidades
de la plataforma, vamos a crear un
sencillo navegador web. Selecciona-
mos el menu File > New > Project...

y en la ventana que aparece a conti-
nuacién seleccionamos Android Pro-
ject. Eclipse abrird un asistente que
generard el esqueleto de una aplica-
cién sencilla. Simplemente rellena-
mos los campos de esta nueva ven-
tana con los mismos que pueden
observarse en la figura 3 y pulsamos

el botoén Finish. En la figura 4 pode-
mos ver como queda el entorno de
desarrollo y la estructura de directo-
rios que ha creado el asistente.
Vamos a echar un vistazo mds a
fondo: El archivo principal de nuestra
actividad es AndroidBrowser.java. Cada
una de las actividades (pantallas) del
programa hereda de la clase Activity. El
framework se encarga de llamar al
método onCreate() de nuestra actividad
cuando se lanza la aplicacidén, y en este
caso, lo inico que se hace es, mediante
setContentView(), decirle a Android
qué vista queremos mostrar en la pan-
talla. La vista se referencia mediante
un archivo de recursos llamado R.java.
En principio, la gestién de este archivo
es automadtica y nosotros no tendremos
que preocuparnos por él, ya que seguin
se anadan recursos, Eclipse actualizara
la clase. Todos los recursos de nuestra
aplicaciéon se almacenan dentro del
directorio res. En nuestro ejemplo, se
hace referencia a un recurso llamado
main, que estd en la carpeta layout del
directorio res. En este archivo se des-
cribe la interfaz de usuario como
fichero XML, de forma parecida a como
lo hariamos con un archivo HTML. En
este caso se utiliza un layout llamado
LinearLayout (que dispone todos los
elementos de la interfaz de forma
lineal) y dentro una etiqueta TextView,
que muestra un texto en pantalla. Por
supuesto hay una larga lista de tipos de
layouts y de componentes de interfaz,
como botones, listas, etc...

En la etiqueta TextView, podemos ver
la propiedad android:text="@string/
hello” que hace referencia a una eti-
queta XML en el archivo de recursos
values/strings.xmly que se llama hello.
En este archivo almacenamos todos los
literales de la aplicacién, haciendo mads
sencilla la internacionalizacion de las
aplicaciones.
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New Android Project

Creates anew Android Project resource,

Froject name: | Androiderowser
Contents.

(%) Create new project in warkspace
) Create project from existing source
[[Juee default location!

Location; | Joptfworkspace = — [ Browse...
Froperties

Package namei | ss.Inuxmagazin.ejempla

fctiviey name: | AnchoidBramser

Appication name: | Androiderowser

Figura 3: Asistente para la creacion de una apli-
cacion Android en Eclipse.

Por udltimo, hablaremos del archivo
androidManifest.xml, que contiene una
gran cantidad de informacidn acerca de
la aplicacién, como por ejemplo, nom-
bre de la aplicacién, version, activida-
des que la componen (tendremos que
registrar cada actividad del programa
aqui), informaciéon de permisos y fir-
mas, documentacidn, etc...

Después de este recorrido por este
esqueleto de aplicacion, es hora de eje-
cutarlo. En el explorador de paquetes
de Eclipse, pulsamos con el botén dere-
cho del ratén sobre la carpeta raiz de la
aplicacién y seleccionamos Run as >
Android application. Esto lanzara el
emulador y nos permitird ver a Android
saluddndonos. Pero no vamos a que-
darnos aqui, vamos a continuar cre-
ando nuestro navegador.

Comenzaremos definiendo la interfaz
de usuario sustituyendo el archivo res/
layout/main.xml por el que aparece en el
listado 1. Estamos creando un cuadro de
texto para introducir la URL y un botén
para navegar. Todo de forma declarativa.

Al archivo /res/values/strings.xml le
anadimos la linea que define el texto
“Ir...” para el botén, tal y como se
observa en el listado 2.

Listado 2: strings.xml.

01 <?xml version="1.0"
encoding="utf-8"7>
<{resources>

<string
name="app_name”>AndroidBrowser
</string>

<string
name="go_url”>Ir...</string>
<{/resources>

02
03

04

05




Por dltimo, vamos a afiadir el cédigo
que aparece en el listado 3 al archivo
AndroidBrowser.java. Podemos ejecu-
tarlo igual que lo hicimos antes.

Lo que realmente ocurre en este
cédigo, es que cuando pulsamos el
botén “Ir...”, Android trata de lanzar
un Intent que ya tiene predefinido
(ACTION_VIEW), y al que se le pasa la
URL (como objeto de tipo Uri). Este
Intent ya sabe que para ver este tipo de
contenidos necesita lanzar el navega-
dor del teléfono.

En [1] podemos acceder a tutoriales
y a toda la documentaciéon necesaria
para continuar profundizando.

Android Market

Ya llevas algin tiempo programando
para Android y has creado tu killer
application. ;Y ahora qué? ;Cémo la
distribuyo? Google ha pensado en todo
y ha creado Android Market, un sis-
tema de distribucién de aplicaciones,
tanto gratuitas como de pago. Gracias a
Market cualquiera puede acceder y des-
cargar nuestra aplicacién. Para poder
ofrecerla sélo hay que subscribirse
como desarrollador, lo que tiene un
coste de 25$ (un solo pago).

Android - DESARROLLO

- Android Emulator (5554)

www.linux-magazine.es: Linux Magazine - Distribuciones, So..

Inicio

*Revista
- Numero Actual
+ Archivo

i
®) metaco
L) |

Este Mes en Linux Magazine

SYSADMIN VIRTUAL

Figura 4: Estructura de directorios de la aplicacion.

Por otra parte, a diferencia de App
Store para IPhone, no existen requisitos
para subir una aplicacién, es decir, que
apenas hay filtros, con lo que, en prin-
cipio, nadie va a rechazar nuestro pro-
grama. A cambio, es probable que se

Listado 3: AndroidBrowser.java.

01 package
es.linuxmagazine.ejemplo;

02

03 import android.app.Activity;

04 import android.content.Intent;

05 import
android.view.View.OnClickListe
ner;

06 import android.net.Uri;

07 import android.os.Bundle;

08 import android.view.View;

09 import android.widget.Button;

10 import
android.widget.EditText;

11

12 public class AndroidBrowser
extends Activity {

13

14 private EditText url;

15 private Button botonlr;

16

17 @0verride

18  public void onCreate(Bundle

ate);

20
setContentView(R.Tayout.main);

21

22 url = (EditText)
findViewById(R.id.url_text);

23 potonlr = (Button)
findViewById(R.id.nav_button);

24

25
botonlr.setOnClickListener(new
OnClickListener() f

26 public void onClick(View
view) {

27 Uri uri =
Uri.parse(url.getText().toStri
ng());

28 Intent browselntent =
new Intent(Intent.ACTION_VIEW,
uri;

29
startActivity(browselntent);

30 }

inunde de aplicaciones mal hechas o
que directamente no funcionen, pero
Market ofrece un sistema de puntuacio-
nes por votacién que pretende corregir
este problema y facilitarnos el acceso a
aplicaciones de calidad.

Conclusiones

Cualquiera que haya programado para
otras plataformas, como Symbian, sabe
lo complicado que es todo el proceso. En
especial, Symbian, ademds de tener un
modelo de aplicacién bastante complejo,
la propia Nokia pone obstdculos a los
desarrolladores de software libre con su
modelo de firmado y restricciones de
capacidades.

En Android todo es muy diferente. El
propio sistema es libre, y tanto el entorno
de desarrollo como el framework son
extremadamente simples en cuanto se
coge algo de prdctica. Para el desarrolla-
dor, Android ofrece sencillez y acceso a
todas las capacidades del terminal. [ |

[1] Pagina desarrolladores Android:
http.//developer.android.com/

[2] Pagina del proyecto Eclipse: http:/
www.eclipse.org/

[3] Pagina de Android Market: http./

savedInstanceState) f{ 31 1) www.android.com/market/
19 32 J [4] Pagina principal de Android: http:/
super.onCreate(savedInstanceSt 33 } www.android.com/
WWW.LINUX-MAGAZINE.ES Nuamero 49 53



